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この実験資料について

� ダウンロード⽤ URL
� http://www.hpc.is.uec.ac.jp/yamaki_lab/teaching-jp.html
� 資料と共にsampleファイルが置いてあります．

授業で出てくるvファイルはここに⼊っているので参考にしてく
ださい．（./~.sc というスクリプトを実⾏するとiverilogコンパ
イルから実⾏まで⼀気に⾏ってくれます）

� 佐藤証先⽣の「J2課題解説スライド」がベース
� 佐藤証先⽣のオリジナル→ http://satoh.cs.uec.ac.jp/ja
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参考書

� ⾚い本：
� Verilog-HDL の勉強⽤

� ⻘い本：
� ツールの使い⽅の勉強⽤
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J2課題の目的

� 論理回路の特性 / 設計技術を習得する
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J2課題の実施方法

� 今年は対面実施となります．

� 実施内容や課題は本資料に載っています
- それとは別に，問題のヒントを以下のリンクに随時upします．
http://www.hpc.is.uec.ac.jp/yamaki_lab/teaching-jp.html

- わからないことがあったら対応するので私にメールください
- ⼋巻（yamaki@uec.ac.jp）
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実験の流れ

� 実験初⽇（~p43）
ガイダンス
簡単な組み合わせ回路の設計
問題1〜3

� 実験２⽇⽬（~p60）
順序回路の設計
問題4

� 実験３⽇⽬（~p71）
加減算回路の設計
問題5〜7
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レポート

記載内容と採点基準
- この資料の問題１〜７を全て⾏い，その内容に考察を加えレポートとする
- 問題１〜７全て回答できていることが修了の条件
- 更に出来る⼈は問題８を解くと加点
- 例年，問題７まで解けずに単位を落とす⼈が結構います．

わからない部分は恐れず質問してください．

提出方法
- レポートPDF ファイルを WebClass 上で提出．
- 受付期間内なら何度でも再提出可．

受付期間
- 授業終了から３週間後の23:00まで
- 前半組： 7/30(⽔) の 23:00まで
- 後半組： 8/11(⽉) の 23:00まで
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目次

� 本実験の内容とその意義（論理回路とハードウェア設計）

� verilogの使い⽅

� 簡単な組み合わせ回路（問題１〜３）

� 順序回路（問題４）

� 加減算回路（問題５〜７）

8



9



論理回路とは

� デジタル回路の数学的モデル

� デジタル回路： １と０のデジタル信号のみを⽤いて様々な計算をする回路
（⼀般的には電圧のHighとLowを１と０にデジタル化）

� アナログ回路：連続するアナログ信号を⽤いて様々な計算をする回路

トランジスタ（＝スイッチ）

のみ

コンデンサ 抵抗 コイル トランジスタ

構成部品

構成部品



デジタル回路の利点

� ある機能を実現したい場合，アナログ/デジタル回路どちらでも可だが

アナログ回路

デジタル回路

AND

OR AND

－

＋

アナログ回路 デジタル回路

＋ 回路構成⾃体は簡潔にできる － トランジスタで構成するため複雑

－ 集積化はしにくい ＋ 集積化できる！→ IC (Integrated Circuit)

－ 汎⽤化しにくい（専⽤回路） ＋ 汎⽤化できる！→ CPU

↔

↔

↔

＜例えば加算器＞



ハードウェア？ソフトウェア？

• ⽂脈によりそれぞれが指す意味は多少異なる

一般的には

− ハードウェア：物理的実体を持つ機械部品．
例．CPU，メモリ，マウス，キーボード，ディスプレイ

− ソフトウェア：物理的実体を持たない構成要素．主にプログラムのこと．
例．OS，アプリケーションプログラム，ドライバ

− ハードウェア：専⽤の論理回路による処理

− ソフトウェア：CPUによる (プログラムでの) 処理

処理において使われる時 （ハードウェア処理，ソフトウェア処理）

本実験の文脈はこちら



ハードウェアとソフトウェア 何が違う？
〜ソフトウェア(CPU)の場合〜

• CPUの強みは何でも (プログラムで記述すれば) 処理できる ＝ 汎用的
⇆ 何かの処理に特化しているわけではない

例えば…

• 次のような計算をCPUで実⾏する場合
x = (a×10 + 20) + (b×100−50)

• CPUでは以下のように実⾏に 5 命令（ 5 サイクル）を要する
乗算命令 → 加算命令 → 乗算命令 → 減算命令 → 加算命令



ハードウェアとソフトウェア 何が違う？
〜ハードウェアの場合〜

• その処理専⽤の回路（ASIC）を作れば⾼速に処理できる

例えば…

• 先ほどの例↓
x = (a×10 + 20) + (b×100−50)

• ハードウェアでは 1 サイクル で計算が完了する

AND

OR AND

a

b

OR

OR

x = (a×10 + 20) + (b×100−50) を計算する回路
（この回路は適当…）

Tips

ソート処理を考えてみると
より差がわかりやすい．

ソート処理はCPUの場合，
値の⼤⼩で⼊れ替えを繰り
返すので結構なサイクルを
要する
⼀⽅でハードウェアの場合，
ソート回路に値を⼊れると
1サイクルで結果が得られる

超⾼速



ハードウェアとソフトウェア 何が違う？
〜まとめると〜

• ハードウェア処理は超⾼速
• また，(あまりにも複雑な処理でなければ) CPUやメモリを実装するより

専⽤論理回路を実装したほうが⼩規模

小型とか超高速を重視する処理において有用

例えば…

・動画像処理

・組み込み機器系（監視カメラ，IoTセンサとか）の処理

・ルータのパケット処理



ハードウェア設計（この実験）

• ハードウェア（専⽤論理回路）はどうやって作る？

① まず仕様を満たす論理回路の設計図を作成する
− 仕様から状態遷移図・真理値表を描き，⼊出⼒の論理式を求める
− 導いた論理式をもとに回路図を作成

② テストベンチを⽤いて設計した回路の動作を検証
− 回路作成には膨⼤なお⾦がかかるので失敗はできない
− シミュレーションにより回路が所望の動作をするか徹底的に検証

③ 論理回路（実物）を作成
膨⼤なお⾦をかけて外注する

論理回路設計の講義でやった

ハードウェア記述言語 verilog



ハードウェア設計の③について

• 実物の回路を作ってもらうにはとにかくお⾦がかかる（数百万円〜）

• そこで最近は FPGA (Field Programmable Gate Array) が出てきた

• FPGAは…
− 論理回路を（外注せずとも）

⾃作できるハードウェア
− FPGAのお値段は数万円〜
− 回路を作る費⽤はタダ
− しかも設計した論理回路を

⾃分でPC上で焼ける
− 何度でも焼き直し可能という
夢のようなデバイス



FPGA（のイメージ）
Field Programmable Gate Array

• ゲート (トランジスタ) がアレイ (格⼦) 状に配置されている

• Verilog で作成した回路となるようにFPGAのゲートを配線
→ 所望の論理回路を作成できる（配線しなおすことも可能）

FPGA（イメージ）

AND

OR AND

こういう回路を

作ってください
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Verilog-HDL の例：AND回路のモジュール
（sample1.v）
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sample1
a

b

s

module sample1(s, a, b); /* モジュール名(入出力端子)
input a, b;             /* 入力端子a, bの宣言
output s;               /* 出力端子sの宣言
assign s = a & b;     /* s に a (and) b を接続

endmodule

� まずは以下のverilogプログラムを⾃分で作ってみましょう
コマンドラインで $ vi sample1.v または $ emacs sample1.vとし
以下を作成



Verilog-HDL の例： wireの使い方
（sample2.v）
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sample2
a

b

s

module sample2(s, a, b);  /* モジュール名（入出力端子）
input a, b;                   /* 入力端子a, bの宣言
output s;                      /* 出力端子sの宣言
wire w1, w2;                 /* 配線w1, w2の宣言
assign w1 = a & b;             /* w1 に a (and) b を接続
assign w2 = a | b;             /* w2 に a (or) b を接続
assign s = w1 & w2; /* s に w1 (and) w2 を接続

endmodule

w1

w2

� モジュール内で必要になる配線はwireで宣⾔
� assign⽂は出⼒や配線に接続するための構⽂（後述するregはassignを使わない）



Verilog-HDL の例：モジュールの入れ子
（sample3.v）
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sample3
a

b

s

module sample3(s, a, b);  /* モジュール名（入出力端子）
input a, b;                   /* 入力端子a, bの宣言
output s;                      /* 出力端子sの宣言
wire w1, w2;                 /* 配線w1, w2の宣言
sample1 m1(w1, a, b);           /* sample1モジュールを呼び出し
sample1 m2(s, w1, w2);          引数の順番はsample1.vと対応
assign w2 = a | b;             /* w2 に a (or) b を接続

endmodule

w1

w2

� モジュール内で別モジュールを呼び出すことも可能

sample1
m1 sample1

m2

sample2のand回路を
sample1モジュールに
変えてみた



モジュールの実装→動作確認
（テストベンチ）
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sample2
a

b

s
w1

w2

� 以上で簡単な回路ならもう記述できるようになりました

� モジュールが完成したら，その動作確認が必要

� 以下の回路なら，aとbにテスト信号を流し，正しいsが得られるか確認
a, bが(0,0), (0,1), (1,0), (1,1) の時，sが 0, 0, 0, 1 になるかどうか

� 作ったモジュールに⼿を加えて動作確認するのはよろしくない
そこで動作確認⽤のテストベンチモジュールを作る



Verilog-HDL の例：sample1のテストベンチ
（sample1_test.v）
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等価

sample1_test (テストベンチモジュール)

z

module sample1_test; 
wire z;
reg x, y;
sample1 g1(z, x, y);
initial /* イベントの生成

begin
$monitor(" %b %b %b", x, y, z, $stime);
$display(" x y z                time");

x=0; y=0; /* 0サイクル目
#50  y=1; /* 50サイクル目
#50  x=1; y=0; /* 100サイクル目
#50  y=1; /* 150サイクル目
#50  $finish; /* 200サイクル目

end
endmodule

x

y

sample1

g1

テストベンチの場合，
入出力端子は作らない．
入力側をregで
(詳しくは後述) 
出力側をwireで宣言．
間違えやすいので注意

モニタで指定した信号に

(今回ならx,y,z,stime)
変化があった場合に
ディスプレイ出力

C言語でいう
Printf

a
b

s

テストイベント
今回は50サイクル毎に
入力値を変化



iverilogを使った動作確認

26

�コンパイル
iverilog -o 実⾏ファイル名 -s トップモジュール名 コンパイルしたい.vファイル群

→ エラーが出なければsample1というファイルが作成される

�シミュレーションの実⾏
vvp 実⾏ファイル名 または 実⾏ファイルを直接指定 ./sample1

→ ⾃分が意図した通りの結果となっているか確認

$displayの内容

$monitorの内容



一致検出回路 (eq.v)
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a b s

0 0 1

0 1 0

1 0 0

1 1 1

module   eq(s, a, b); /* 一致検出回路 */
input  a, b;
output s;
wire   na, nb, s1, s2;
assign na = ~a, nb = ~b;
assign s1 = a & b, s2 = na & nb;
assign s  = s1 | s2;

endmodule

真理値表 回路図

各記号の意味
• ~: NOT演算
• &: AND演算
• |:  OR演算

!

"

#

#$

#%

&'

&%

&$

&(

&)

*"

*!

入力a,bが一致した時に出力sが１



一致検出回路のテストベンチ (eqSim.v)
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module eqSim;      /* 一致検出回路の */
wire   s;        /* シミュレーション */
reg x, y;
eq g1(s, x, y);
initial

begin
$monitor(" %b %b %b", x, y, s, $stime);
$display(" x y s                time");

x=0; y=0;
#50 y=1;
#50 x=1; y=0;
#50 y=1;
#50 $finish;

end
endmodule

制御記述

レジスタ宣⾔
モジュール呼び出し

遅延

s
x

y

eq
s

a

b
[ シミュレーション用回路 ]

time

x 1

0

y 1

0
0 50 100 150 200

[ テスト入力の時間変化 ]

テスト⼊⼒

eqSim
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すみません，今年度はCEDの環境変更に伴いModelSimが使えません

代わりに gtkwave というツールを使います
使い方は Webclass の実験ページに書いてありますので

そちらを参照してください



ModelSimの起動とプロジェクト作成

1. コンソールで”mkdir ~/mics_J2”と⼊⼒
2. コンソールで”vsim”（今年は”vsim2”？）と⼊⼒
3. File→New→Proeject... で“Create Project”ウィンドウが開く
4. Project Name： eq
5. Project Location： /path_to_homedir/mics_J2
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Verilog-HDLファイルの追加
1. “Add  items to the Project”ウィンドウ： Add Existing File

またはメインウィンドウから Project→Add to Project→Existing File…
2. “Add file to Project”ウィンドウ： Browse
3. “Select files to add to project”ウィンドウ：
4. eq.v と eqSim.v を選択して開く．
5. “Add file to Project”ウィンドウ： OK
6. “Add  items to the Project”ウィンドウ： Close
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コンパイル

� メインウィンドウ：Compile→Compile All
� Verilog-HDLファイルのStatusが？からㇾに変わり、“Compile of 

eqSim.v was successful.” “Compile of eq.v was successful” と出る．
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コンパイルエラー

� エラーがあるとTranscriptウィンドウに⾚く表⽰されるので，そこ
をダブルクリックするとエラーの詳細が表⽰される

� さらに“** Error: “の⾚い⾏をクリックするとソースコードウィンド
ウが開いてエラーの⾏がオレンジで表⽰される
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1つのコンパイルエラー

~aが_aになっている

コンパイル失敗

5⾏⽬のʼ_aʼに⽂法エラー



シミュレータ起動
� Simulate→Start Simulation
� Start Simulationウィンドウでwork/eqSimを選択
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シミュレーション設定
� シミュレーションウィンドウが開く
� Add→add to wave→all items in regionで波形ウィンドウが開く
� “All items in region and below”と”All items in design”は下位レベ

ルやソースの全ての信号線が表⽰される
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シミュレーション設定
� ウィンドウが⼩さいので  ボタンを押して拡⼤
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シミュレーション実行
� メインウィンドウで，Simulate→Run→All
� Finsh Vsimウィンドウで「いいえ(N)」を選択

� 「はい(Y)」を選択するとModelSimが終了してしまうので注意
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シミュレーション結果表示
� Waveウィンドウに結果が表⽰される
� 画⾯を⾍眼鏡で拡⼤して表⽰
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ｘ＝ｙ＝０
でｓ＝１

ｘ＝ｙ＝1
でｓ＝１



シミュレーション結果表示
� シミュレーションモジュールに$monitorコマンドを記述しているの

でTranscriptウィンドウにテキストでも表⽰される
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再シミュレーション
� メインウィンドウで Simulate→Restart
� Restartウィンドウが出るのでOKをクリック
� ｢シミュレーションの実⾏｣に戻って再シミュレーション
� 全てのコマンドはTranscriptウィンドウで実⾏されているので，

ここに⼿⼊⼒した⽅が早い
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←リスタートコマンド
←シミュレーションコマンド



内部信号の表示
� Simウィンドウでモジュールを指定し,内部信号を表⽰
� $monitor関数では “g1.s1”のようにモジュール内の信号やさらに”.”でつ

ないでモジュール内のモジュールを指定
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別回路のシミュレーション

� Simulate→End Simulation
� Projectウィンドウで右クリックしてポップアップメニューを出し，

Add to Project→Existing File...
� eq2.v と eqSim2.v を追加
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別回路のシミュレーション
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A B A=B

0 0 1

0 1 0

1 0 0

1 1 1

module   eq2(s, a, b);
input  a, b;
output s;
wire   s1, s2;

  assign s1 = ~(a & b), s2 = a | b;
assign s  = ~(s1 & s2);

endmodule

真理値表 回路図
!

"

#

#$

#%

&'

&(

&)



別回路のシミュレーション
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module eqSim2;
wire   s;
reg x, y;
eq2    g(s, x, y);

initial
begin

$monitor(“ %b %b", g.s1, g.s2, $stime);
$display("g.s1 g.s2 time");

x=0; y=0;
#50  x=1;
#50  y=1;
#50  x=0;
#50  $finish;

end
endmodule

eqSim2
sx

y

eq2

ga
b

s



別回路のシミュレーション
� Window内の追加したファイルを選択して，

Compile→Compile Selected(選択したファイルが対象)または
Compile All(すべてのファイルが対象)でコンパイル
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別回路のシミュレーション

� Libraryタグのworkの下に，eq2とeqSim2ができている
� eqSimと同様にeqSim2をシミュレーション

46どうなりましたか︖



プロジェクトの変更
� File→Close Projectでプロジェクトを閉じる
� File→New Projectで新しいプロジェクトを作る

� 前のプロジェクトを閉じていない時は閉じるかどうか聞かれる
� Project Name: eq2で新しいプロジェクトを開く

� 他のプロジェクトとモジュールを共有するときや，名前が同じ異なるモ
ジュールがなければDefault Library Name: workでよい
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プロジェクトの変更
� プロジェクトeqに戻るときはFile→Resent Projectから選ぶか，

File→Openでファイル選択のポップアップウィンドウの右下
を“Project Files”に切り替えてmpf (Modelsim Project File)
ファイルを表⽰して選択

48
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問題１

� モジュール eq の動作検証を eqSim を⽤いて⾏い，出⼒結果が
正しくなるかどうか確認せよ．なお，検証には$monitorを⽤い， 
x, y, s をCUI上に表⽰して確認すること．

� また，eqSimを改良し，eqモジュールの内部信号であるs1, s2
を$monitorでCUI上に表⽰できるようにせよ．
$monitor⽂において，⼊れ⼦となっているモジュールの内部信
号を観測するには “モジュール名.信号名” を使う．例として，
p.35のeqSim2の$monitor⽂，$display⽂を参考にせよ．
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問題２

�⼊⼒信号 a, b, c, d を受け取り，a = b とc = d がともに成り⽴
つとき出⼒信号 s を 1 に，それ以外のときs を 0 にする回路の
モジュールを，モジュールeq を 2 個使って作れ．
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問題３

� 問題２で設計したモジュールの動作検証を⾏うテストベンチを
作成せよ．また，作成したテストベンチモジュールを⽤いて，
動作検証せよ．動作検証は，ModelSimを⽤いて，⼊出⼒信号
の波形をGUI表⽰して確認すること．
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組み合わせ回路と順序回路

� 組み合わせ回路：現在の⼊⼒のみによって出⼒が⼀意に決まる
ここまで作成してきた回路は全て組み合わせ回路

� 順序回路：過去の⼊⼒により出⼒が変化する
→ すなわちデータを記憶している
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Dフリップフロップ
最も単純な順序回路
クロック信号に同期して出⼒を⽣成
従って次の周期に達するまでは⼊⼒が変化しても出⼒は不変
＝ 前周期の⼊⼒が次周期まで記憶される

QD q

ck
d

d1

ck

s1

s2

nl
l ck

#50



Verilogでの順序回路作成

� レジスタ(reg)とalways⽂を使うことで，順序回路を作成できる
� レジスタ…値を保存できる極⼩のメモリ

wireが配線だったのに対し，レジスタ(regとして宣⾔)は
データを格納する箱のイメージ

� always⽂…always @(イベント) 処理内容
“イベント が起こる時，毎回 処理内容 を実⾏する” という構⽂
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Ｄフリップフロップ（Delay Frip Frop ）
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D Q

module dffn(Q, D, ck);
input D, ck;           
output Q;                
reg Q;
initial Q = 0;         
always @(negedge ck) Q = D;

endmodule

ck

dffn
Register

time

ck

D

Q

#50

Q

module clk(ck);
output ck; 
reg ck;
initial ck = 0;

always #50 ck = ~ck;
endmodule

Ckが下がった瞬間の入力Dが出力Q

clk

Reg の値を
output したい時
同じ名前で定義
してもよい

クロック信号生成モジュール clk Dフリップフロップ dffn

50サイクル経過する度に ck の値を反転
Ckが下がる度にその時のDをQ1に保存

レジスタの初期化



Ｄフリップフロップのテストベンチ

module dffnSim;
reg     i;           
wire o;                
clk clk1(ck);
dffn dffn1(o, i, ck);
initial
begin

$monitor(“ %b %b %b”,
ck,i,o,$stime);

$display(“ck i o time”);
i = 0;

#100 i = 1;
#200 i = 0;
#100 $finish;

end
endmodule

D Q

ck

dffn1
Register

Q

clk1

dffnSim

i o



もう少し複雑な順序回路：1ビットの記憶回路
�制御信号ｌでD-FFへの書き込みを制御
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module  r1( q, l, d, ck );
  input     l, d, ck;

output  q;
wire      nl, s1, s2, d1;
dffn f( q, d1, ck );
assign   nl = ~l;
assign   s1 = nl & q,  s2 = l & d;
assign   d1 = s1 | s2;

endmodule

QD q

ck
d

d1

ck

s1

s2

nl
l

QD q

ck
d

q

ck

q

0

1
0

QD q

ck
d

d

ck

0

d

0
1



仕様からverilogで回路を作成するには？

�前⾴のように回路図が与えられれば，もうverilogで書けるはず

� それでは与えられた仕様から回路図を作るには？
（論理回路の講義の復習）

１．まず仕様から状態遷移図・真理値表を作成

２．出⼒と次遷移状態を，⼊⼒と現遷移状態の論理式で表す
(真理値表からカルノー図を⽤いて求める)

３．得られた論理式から回路図を作成

４．回路図をverilogで書き直す

・次ページでは例として，“スイッチaが押された状態でclkが⽴ち下が
ると，3クロックの間，１を出⼒する回路”をverilogで作成する
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逐次制御回路１(仕様→状態遷移表・遷移図)
� 仕様：

スイッチaが押された状態でclkが⽴ち下がると，3クロックの間，１を出⼒
� パラメータ：

- ⼊⼒a
- 出⼒b
-現在の状態s1s0
-次の状態s1ʼs0ʼ
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現在の状態s1s0
00 01 10 11

入力

a
0 00/0 10/1 11/1 00/1
1 01/0 10/1 11/1 00/1

0/0

0/1, 1/1

0/1,1/10/1, 1/1

1/0

a/b⼊⼒ 現在の出⼒
現在状態が00の時
出力bは0
入力aが1なら
次の状態01に遷移

s1’s0’/b次状態 現在の出⼒

状態01, 10, 11の時は
出力bが1となる
入力aは0でも1でも
次の状態に遷移



逐次制御回路１(状態遷移図→真理値表)
� 得られた状態遷移表，状態遷移図を基に真理値表を描く
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現在の状態s1s0
00 01 10 11

入力

a
0 00/0 10/1 11/1 00/1
1 01/0 10/1 11/1 00/1

s1’s0’/b次状態 現在の出⼒

0/0

0/1, 1/1

0/1,1/10/1, 1/1

1/0

a/b⼊⼒ 現在の出⼒

a s1 s0 b s1’ s0’
0 0 0 0 0 0
1 0 0 0 0 1
x 0 1 1 1 0
x 1 0 1 1 1
x 1 1 1 0 0

x はdon’t careと言って，
0でも1でもどちらでも良いという意味

don’t care でまとめるのが難しいなら
a=0, a=1の２行に分けて描いても良い



逐次制御回路１(真理値表→論理式化)
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状態s1s0
00 01 11 10

入力
a

0 0 1 1 1
1 0 1 1 1

b = s0 + s1

s1’ = s1･s0 + s1･s0

s0’ = a･s0 + s1･s0

a s1 s0 b s1’ s0’
0 0 0 0 0 0
1 0 0 0 0 1
x 0 1 1 1 0
x 1 0 1 1 1
x 1 1 1 0 0

状態s1s0
00 01 11 10

入力
a

0 0 1 0 1
1 0 1 0 1

状態s1s0
00 01 11 10

入力
a

0 0 0 0 1
1 1 0 0 1

� b, s1ʼ, s0ʼ それぞれに関してカルノー図を作成し論理式化
� 状態s1s0の00 01 11 10という順番に注意
� カルノー図でまとめられる単位は1, 2, 4…

なので1×1や1×2，2×2でまとめる



逐次制御回路１(論理式→回路図・実装)
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s1’ = s1･s0 + s1･s0
s0’ = a･s0 + s1･s0
b = s1 + s0

module m1( b, a, ck );
input    a, ck;
output  b;
wire     ns1, ns0, s1, s0, d1, d0, c1, c2, c3;
dffn f1( s1, d1, ck ), f2( s0, d0, ck );
assign  ns1 =  ~s1, ns0 = ~s0;
assign  c1   =  s1 & ns0, c2 = ns1 & s0,

c3   =  a & ns0;
assign  d1   =  c1 | c2, d0 = c1 | c3,

b   =  s1 | s0;
endmodule

QD

ck

QD

ck

d1

d0 s0

s1

b

ns1

ns0

a
c3

c2

c1

ck

s1

s0

今回は状態s1s0で
2bit分のFFが必要

2個のFFを中心に
b, s1’, s0’を信号で
接続する s1’

s0’

図が描けたら
verilogで
書き直すだけ



� 順序回路を状態遷移図で表記して動作を解析，あるいは状態
遷移図から順序回路を設計するときにはFFの値が「状態」を
表す

� ⼊⼒と出⼒によってその状態間がどう遷移するかを調べる
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l CS実験第⼀J1課題の回路の動作を調べる
- ⼊⼒はE，出⼒はQ1Q0
- 状態はQ1Q0（D-FFから直接なので出⼒と⼀致）
- 2bitなので最⼤で4状態だが，全ての組合せを取らない場合もある

Q1QD

QD Q0

T
E

逐次制御回路２(回路図→状態遷移表→仕様)
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Q1QD

QD Q0

T
E

状態Q1Q0＝00の場合
� E＝0の時， Qʼ1＝0 Qʼ0＝0となる
� E＝1の時， Qʼ1＝0 Qʼ0＝1となる

Q1QD

QD Q0

T
E

状態Q1Q0＝01の場合
� E＝0の時， Qʼ1＝0 Qʼ0＝1となる
� E＝1の時， Qʼ1＝1 Qʼ0＝0となる

逐次制御回路２(状態遷移の確認)
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Q1QD

QD Q0

T
E

状態Q1Q0＝10の場合
� E＝0の時， Qʼ1＝1 Qʼ0＝0となる
� E＝1の時， Qʼ1＝1 Qʼ0＝1となる

Q1QD

QD Q0

T
E

状態Q1Q0＝11の場合
� E＝0の時， Qʼ1＝1 Qʼ0＝1となる
� E＝1の時， Qʼ1＝0 Qʼ0＝0となる

逐次制御回路２(状態遷移の確認)
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逐次制御回路２(真理値表・状態遷移図)

E Q1 Q0 Q’ 1 Q’0
0 0 0 0 0
0 0 1 0 1
0 1 0 1 0
0 1 1 1 1
1 0 0 0 1
1 0 1 1 0
1 1 0 1 1
1 1 1 0 0

0/010/00

0/100/11
1/10

1/011/11

1/00

E/Q1Q0

⼊⼒ 現在の出⼒

状態遷移図の作成真理値表からE,Q1Q0とQʼ1Qʼ0の関係を求める

１が⼊⼒されるたびに，カウントアップされた値（<4）を出⼒する回路
だとわかる



� カルノー図からQ1, Q0 の式が求められる
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Q’ 1 ＝ E・Q1・Q0 + Q1・Q0 + E・Q1

Q’ 0 ＝ E・Q0 + E・Q0

→ 回路図と照らし合わせて

 一致しているかどうか

逐次制御回路２(論理式の確認)

状態Q1Q0
00 01 11 10

入力

E
0 0 0 1 1
1 0 1 0 1

E Q1 Q0 Q’ 1 Q’0
0 0 0 0 0
0 0 1 0 1
0 1 0 1 0
0 1 1 1 1
1 0 0 0 1
1 0 1 1 0
1 1 0 1 1
1 1 1 0 0

状態Q1Q0
00 01 11 10

入力

E
0 0 1 1 0
1 1 0 0 1



問題４

�以下の状態遷移表m2に従って動く回路m2の状態遷移図を書き，
回路を設計せよ．

� なお，回路m2は，初期状態 0 において⼊⼒ a に 1 が⼊⼒された状
態でクロックが⽴ち下がると，状態 1 に遷移する．
以降，同様の操作が⾏われる度に状態２，３と遷移し，最終的に出
⼒ b  から 1 を出⼒し，初期状態 0 に戻る.

� 回路m2とそのテストベンチを実装し，シミュレーションで動作
を確かめよ．ただし，回路m2の状態は，reg ではなく ，2個の
dffn を⽤いて実装すること．

� 上記のシミュレーション結果の何をもって動作確認としたのかも
説明せよ．
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現在の状態s
0 1 2 3

入力

a
0 0/0 1/0 2/0 3/0
1 1/0 2/0 3/0 0/1

s’/b次状態 現在の出⼒
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多ビットデータの表現
� 多ビットのデータは，x[3:0]のように配列で表す（＝x[3]x[2]x[1]x[0]の4bit値）
� Parameter 宣⾔を使うことでビット数を容易に変更できる
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module eor4( z, x, y );
  input   [3: 0]  x, y;
output  [3: 0]  z;
wire [3: 0] nx, ny, z1, z2;
assign  nx = ~x, ny = ~y;
assign z1 = x & ny, z2 = nx & y,

z  = z1 | z2;
endmodule

module eorn( z, x, y );
parameter  n = 8;
input   [n-1: 0]  x, y;
output  [n-1: 0]  z;
wire [n-1: 0] nx, ny, z1, z2;
assign  nx = ~x, ny = ~y;
assign z1 = x & ny, z2 = nx & y,

z  = z1 | z2;
endmodule

eorn #4 e(g,a,b)
と呼び出すことで
n=4に指定を変えることも可能

x[ 3: 0]
4

4

y[ 3: 0] 4 z[ 3: 0]

x[ n-1: 0]
n

n

y[ n-1: 0] n z[ n-1: 0]



ビットベクトル

� { }で信号を囲むことで複数の信号をまとめることが可能
� 例えば，x[3:0]というのは{x[3:2], x[1:0]}  {x[3], x[2], x[1], x[0]} と同じ

� ビットベクトルを使うとシフト操作等が実現できる
左シフト：{x[2:0], 1ʼb0}  左巡回シフト：{x[2:0], x[3]}
右シフト：{1ʼb0, x[3:1]}  右算術シフト：{x[3], x[3:1]}
※ 1ʼb0というのは1桁のb(2進数)の0という意味

例えば2進数の11も2ʼb11と書かないと10進数の11扱いされてしまう
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module   lshift( y, x );
input   [3:0]   x;
output  [3:0]   y;
assign  y = {x[2:0], 1’b0};

endmodule

左1bitシフトのモジュール例



問題５の前提知識１ (加算回路の設計)
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l全加算器(Full Adder)
は下からの桁上げを考
慮した3⼊⼒の加算器

cu=a･b＋a･c＋b･c
s = a･b･c＋a･b･c

+a･b･c＋a･b･c

a b c cu s
0 0 0 0 0
0 0 1 0 1
0 1 0 0 1
0 1 1 1 0
1 0 0 0 1
1 0 1 1 0
1 1 0 1 0
1 1 1 1 1

桁上げ cu = a & b | b & c | c & a
和     s = a & ~b & ~c | ~a & b & ~c | ~a & ~b & c | a & b & c

 = a ^ b ^ c

a b

cu

s

c

!

"#$

a
b s

cuf a
c

ab

cu

s
c



問題５の前提知識２ (加算回路の設計)
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a
b s

cuf a
c

� 1ビット全加算器の場合（前⾴を参考に）

� 4ビット加算器を作るには？

module   fa( cu, s, a, b, ci);
input   a, b, ci;
output  cu, s;
assign  s = a ^ b ^ ci;
assign  cu = a & b | b & ci | a & ci;

endmodule

module add4( cu, s, x, y, ci );
input  [3: 0] x, y;
input         ci;
output        cu;
output [3: 0] s;
wire   [3: 0] c;
fa a3( cu, s[3], x[3], y[3], c[3]),

a2(c[3], s[2], x[2], y[2], c[2]),
a1(c[2], s[1], x[1], y[1], c[1]),
a0(c[1], s[0], x[0], y[0], ci);

endmodule

c
fa

a b

scu

c
fa

a b

scu
0

c
fa

a b

scu
1

x0y1

s1

x1y2

s2

x2x3 y3 y0

s0s3

1 0 0 0 1 1 1 1

1

10 011

c
fa

a b

scu

c3 c2 c1 ci

cu

11

1
0101

+
011
0 110
0 1011

10

ci



問題５ (加算回路の設計)

� 前⾴による実装ではn ビットの加算器は作れない．なぜなら，faモ
ジュールをn個宣⾔することがverilogではできないからである．では，
n ビット加算器はどうすれば実装できるか？faモジュールを⽤いずに
ビットベクトルを使ってn ビット加算器を作成せよ．

� このモジュールはadd4 のように、最上位の桁上げcu と、最下位に
加えるci を持つこと。

� さらに、シミュレーションにより評価せよ。

（ヒント）
問題を解く肝になるのは，add4の”fa  a3(~), a2(~)…a0(~);”の部分を
いかにビットベクトルを⽤いて書き直すかである．次ページを参考に
考えてみてください．
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� 例：４bit加算器の場合
� ⼊⼒

被加数 x[3:0]，加数 y[3:0]，最下位の桁上げ ci 
� 出⼒

加算結果 s[3:0]，最上位の桁上げ cu
� 途中の桁上げ c[3:0] 

c[3]…3桁⽬からの桁上げ, c[2]…2桁⽬からの桁上げ
c[1]…1桁⽬からの桁上げ, c[0]…0桁⽬からの桁上げ（=ci)

x[0] + y[0] + c[0] =  
s[0]c[1]

x[1] + y[1] + c[1] =  
s[1]c[2]

x[2] + y[2] + c[2] =  
s[2]c[3]

x[3] + y[3] + c[3] =  
s[3]cu x[3] & y[3] | x[3] & c[3] | y[3] & c[3] = cu

x[2] & y[2] | x[2] & c[2] | y[2] & c[2] = c[3]
x[1] & y[1] | x[1] & c[1] | y[1] & c[1] = c[2]
x[0] & y[0] | x[0] & c[0] | y[0] & c[0] = c[1]

x[3] ^ y[3] ^ c[3] = s[3]
x[2] ^ y[2] ^ c[2] = s[2]
x[1] ^ y[1] ^ c[1] = s[1]
x[0] ^ y[0] ^ c[0] = s[0]

・4桁からn桁に拡張した場合どういう式になる？

・4つの式をビットベクトルでまとめると？



条件付きassign文

� 条件はC⾔語と同じ >,<, >=,<=, ==, != , <=などが，ま
たその論理積(&&)や論理和(||)などが利⽤できる
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assign 変数= 条件? 条件が1(真) のときの値:
                                条件が0(偽) のときの値;

assign z = c? x: 0; assign z = c? x: y; assign z = c? x:
 d? y: w;

x

c

z
0

!

"

x

c

z
y

!

"

x
c z

y

d

w
!

"
c

z
!

"

x



繰り返し動作の記述（参考程度）
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module sel( z, x, c );
  parameter n = 4;
input [n-1: 0] x;
input c;
output [n-1: 0] z;
assign z = c? x: 0;

endmodule

for (制御変数の初期設定; 継続条件;
制御変数の変更) 文;

module selSim;
reg [3:0]  x;
reg c;
wire [3:0] z;
sel sel1(z, x, c);
initial
begin
$monitor("%b %b %b", x, c, z);
c = 0;
for(x=0; x<8; x=x+1) #50 c=~c;
#50 $finish;

end
endmodule



問題６ ( n ビットレジスタ) 

� クロック同期して動作し，以下に⽰す仕様を満たすn ビットレジ
スタのモジュール r を設計し、シミュレーションにより評価せよ．

�ちなみに１ビットレジスタの例はP.49に載せている．

� この問題では，P.49の１ビットレジスタに対して
①データのビット幅をｎビットに拡張
②セレクタを⽤いて回路をより簡単化 すること

� データ⼊⼒： d, ck
� 制御信号⼊⼒： load
� データ出⼒：    q
� 動作：             load = 0 のときq = q 

load = 1 のときq = d
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問題６ ( n ビットレジスタ) 
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問6モジュール

d (n bit)

load (1 bit)

ck (1 bit)

q (n bit)load=1の時 q = d
load=0の時 q = q



問題６ ( n ビットレジスタ) 
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問6モジュール

d (n bit)
load (1 bit)

ck (1 bit)

load=1の時 q = d
load=0の時 q = q

QD q

ck
d

d1

ck

s1

s2

nl
l

q (n bit)



問題６ ( n ビットレジスタ) 
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問6モジュール

d (n bit)

load (1 bit)

ck (1 bit)

load=1の時 q = d
load=0の時 q = q

QD q

ck
d

d1

ck

s1

s2

nl
l

q (n bit)0 

1



問題７ (加減算回路の設計) 
� 問題5の加算回路をベースに，以下の仕様のn 桁の加減算回路の

モジュールを設計し、シミュレーションにより評価せよ．ただ
し負の数は2の補数表現とする．
� 数の⼊⼒： n 桁の整数x, y
�制御信号入力： k
� 出⼒：            桁上げcu とn 桁の和s
� 動作：             k = 0 のときs = x + y

k = 1 のときs = x − y
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負数を2 の補数で表したとき、x − y = x + y + 1 である．した
がって，k の値によって y と y の何れかを選ぶ選択回路の出
力とx を加算すればよく，1 の加算には、桁上げ入力を使う．
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問題8 オプション課題

Xilinx VivadoとNEXYS 4を用いて,
加算器(問題5のadd4モジュール)を

FPGA上で動作させよ.

以下のURL からファイルをダウンロードし，作成したディレクトリに保存
http://www.hpc.is.uec.ac.jp/yamaki_lab/experiment/add4_nexys4.xdc

（コンソールでwget http://www.hpc.is.uec.ac.jp/yamaki_lab/experiment/add4_nexys4.xdc ~/mics_J2/）



NEXYS 4
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[出典] https://reference.digilentinc.com/_media/nexys:nexys4:nexys4_rm.pdf



add4の実行
� SW7-0の切り替えに応じてLEDが点灯する
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SW15-0

LED



FPGAの用途
� FPGA

� Field Programmable Gate Array
� ユーザが論理機能を何度でも書き換え可能
� 少量多品種・短ライフサイクル品

� ASIC
� Application Specific Integrated Circuit
� 回路の論理が固定の特定アプリケーション⽤のカスタム品
� プロセッサ等の⼤量⽣産品
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２⼤メーカー



#LED vivado 計算結果を出力するLED(1だと点灯、0だと無灯)

set_property PACKAGE_PIN R18 [get_ports {cu}]
set_property IOSTANDARD LVCMOS33 [get_ports {cu}]
set_property PACKAGE_PIN N14 [get_ports {s[3]}]
set_property IOSTANDARD LVCMOS33 [get_ports {s[3]}]
set_property PACKAGE_PIN J13 [get_ports {s[2]}]
set_property IOSTANDARD LVCMOS33 [get_ports {s[2]}]
set_property PACKAGE_PIN K15 [get_ports {s[1]}]
set_property IOSTANDARD LVCMOS33 [get_ports {s[1]}]
set_property PACKAGE_PIN H17 [get_ports {s[0]}]
set_property IOSTANDARD LVCMOS33 [get_ports {s[0]}]

#PUSH BUTTON
set_property PACKAGE_PIN N17 [get_ports {ci}]
set_property IOSTANDARD LVCMOS33 [get_ports {ci}]

xdcファイル:FPGAのピン配置を決めるファイル
まずはFPGAボードを確認



#SWITCH vivado 4ビットの値を入力するスイッチ

set_property PACKAGE_PIN R13 [get_ports {x[3]}]
set_property IOSTANDARD LVCMOS33 [get_ports {x[3]}]
set_property PACKAGE_PIN U18 [get_ports {x[2]}]
set_property IOSTANDARD LVCMOS33 [get_ports {x[2]}]
set_property PACKAGE_PIN T18 [get_ports {x[1]}]
set_property IOSTANDARD LVCMOS33 [get_ports {x[1]}]
set_property PACKAGE_PIN R17 [get_ports {x[0]}]
set_property IOSTANDARD LVCMOS33 [get_ports {x[0]}]
set_property PACKAGE_PIN R15 [get_ports {y[3]}]
set_property IOSTANDARD LVCMOS33 [get_ports {y[3]}]
set_property PACKAGE_PIN M13 [get_ports {y[2]}]
set_property IOSTANDARD LVCMOS33 [get_ports {y[2]}]
set_property PACKAGE_PIN L16 [get_ports {y[1]}]
set_property IOSTANDARD LVCMOS33 [get_ports {y[1]}]
set_property PACKAGE_PIN J15 [get_ports {y[0]}]
set_property IOSTANDARD LVCMOS33 [get_ports {y[0]}]

xdcファイル:FPGAのピン配置を決めるファイル
まずはFPGAボードを確認



Vivadoを起動
● Terminal で vivadoと入力
● Create New Projectをクリック



プロジェクトディレクトリを指定
● Project name: add4
● Project location: 任意のディレクトリ
● Create project Subdirectoryにチェック



プロジェクトタイプの指定
RTLプロジェクトにチェック



ソースファイルの指定

� Add filesで次のファイルを追加
    add4.v, fa.v



制約ファイルを追加
� Add filesで次のファイルを追加   add4_nexys4.xdc



デバイスの指定:
XC7A100T-CSG324を選択

� Family: Artix-7 �Package: csg324 �Speed grade: -3



設定内容を確認



Vivadoプロジェクトトップページ



コンパイルの実行
Sources ウィンドウで add4 を選んで Generate Bitstreamを実行し 
Yes をクリック 



コンパイルの実行

OKをクリック



Bitstream Generation successfully completed が
でたら成功

コンパイル成功



FPGAの電源を入れる

FPGAの電源は mini USB経由で
PCから電源供給



FPGAへ書き込み

Open Hardware Manager を
クリック

Open target をクリック



FPGAへ書き込み

Program device をクリック



FPGAへ書き込み

Program をクリック



add4の動作確認
例：0011 + 0001 = 0100


